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Disclaimers 

Copyright © 2013 Raveon Technologies Corporation 
All rights reserved.  
The information in this document is subject to change without notice. The statements, configurations, technical 
data, and recommendations in this document are believed to be accurate and reliable, but are presented 
without express or implied warranty. Users must take full responsibility for the applications of any products 
specified in this document. 
RAVEON TECHNOLOGIES DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, 
INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL 
CMU BE LIABLE FOR ANY SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES 
WHATSOEVER RESULTING FROM LOSS OF USE, DATA, OR PROFITS, WHETHER IN AN ACTION OF 
CONTRACT, NEGLIGENCE, OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION 
WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. 
The information in this document is proprietary to Raveon Technologies, Inc. 

Trademarks 
Raveon, M7 GX, ATLAS and RavTrack are trademarks of Raveon Technologies Corporation. 
All other trademarks are the property of their respective owners. Mention of third-party products is for 
informational purposes only and constitutes neither an endorsement nor a recommendation. Raveon assumes 
no responsibility with regard to the performance or use of these products. 

Statement of Conditions 
In the interest of improving internal design, operational function, and /or reliability, Raveon Technologies, Inc. 
reserves the right to make changes to the products described in this document without notice. 
Raveon Technologies, Inc. does not assume any liability that may occur due to the use or application of the 
product(s) or network configurations described herein. 
 
 
 
 
 
Raveon Technologies Corporation 
2461 Impala Drive 
Carlsbad, CA 92010 
USA 
sales@raveon.com 
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Documentation and ConventionsDocumentation and ConventionsDocumentation and ConventionsDocumentation and Conventions    Section1 

General 

This manual uses the following conventions to present information: 

Convention (TypeFace) Description 

Convention (Typeface) Description 

bold italic Menu commands and button names 
bold italic sans serif Web GUI page links 

terminal Computer display text 

bold terminal User-entered text 

Italic Italic type indicates the titles. 

Icon  Description 

 

Requests that you pay particular attention to a 
specified procedure or piece of information in the 
text. The NOTE message has a regular type style. 

 

Information shown here describes a difference 
between the Lite version of the program and the 
Standard version of the program. . 

 

CAUTION Icon: Suggest you review the 
referenced details and heed the instructions 
offered. The CAUTION message has a bold type 
style. 

 

WARNING Icon: Demands that you observe the 
actions given in the text. The WARNING 
message has a bold italic type style. 

 

COMPASS Icon: Points the user to additional 
information concerning the topic under discussion. 
The COMPASS message has a regular type style.  
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Overview of Major CapabilitiesOverview of Major CapabilitiesOverview of Major CapabilitiesOverview of Major Capabilities    Section2 

General 

RavTrack™ PC by Raveon is a PC software application for displaying, tracking, 
alarming, and logging the activity of RavTrack Transponders. 

 

This easy-to use PC application graphically shows the location and status of cars, 
trucks, people, or anything equipped with RavTrack Transponders.  The displayed 
map may be any graphic image, bitmap, or .jpg.  Additional graphics such as lines, 
shapes, and icons may be added by the user.  

 

RavTrack PC Versions 

Information shown here describes a difference between the Trial, Limited and the  
Unlimited license for the RavTrack PC program.  The software activation key 
purchased from Raveon determines the level of functionality.  The table below 
outlines the differences between the various versions of the RavTrack PC.  

Version Duration 
operation  

Number of 
common 
channels 

Multi-user 
operation 

Maximum 
number of 

tracked 
objects 

TCP/IP 
comms 

Logging 
location 

and status 
to disk 

Microsoft 
SQL Server 

Updating 

Trial 
30 days 6 Yes 10 Yes Yes No 
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Lite 
unlimited 1 No Not limited No No No 

Standard 
unlimited 6 Yes Not limited Yes No No 

Server 
unlimited 6 Yes Not limited Yes Yes Yes 

 

The Trial license of the RavTrack PC is strictly for short-term evaluation of the 
program to determine its suitability for a particular use.  All features of the software 
are enabled, but only a maximum of 10 transponders may be tracked and the trial 
version will  not store to Microsoft SQL server databases.    

The Lite license of RavTrack PC is for use on a stand-alone computer or tablet 
that does not share position/tracking information with other computers in its 
network.  Typically the Lite version is used for in-vehicle display or simple position 
visualization.  It does not log to disk, print reports, or receive position reports over 
a network interface.   

The Standard license is suitable for workstations at dispatch, control centers, and 
anywhere that the computer running RavTrack PC Server will be sharing its 
position/status information with other users.  Standard can read data from SQL 
databases, but it does not store GPS position data from GPS transponders to a 
SQL database.  

The Server version has all features of the Standard version, plus it can update and 
manage the database on a Microsoft SQL server. It stores the GPS position and 
status information from GPS transponders to a SQL database (Microsoft Access or 
Microsoft SQL Server).  

Regardless of the type of license acquired from Raveon, one license may only be 
used on one PC.  Multi-user systems must purchase one license per computer.  

Legal Notice 

GPS tracking may be illegal in certain states and in certain circumstances. 
Raveon’s  tracking devices may not be used to violate the privacy rights of others, 
or in violation of local, county, state or federal statutes. In no way will Raveon 
Technologies Corporation, dealers or partners be held responsible for 
inappropriate use of these products. 

IT IS THE SOLE RESPONSIBILITY OF THE BUYER TO CONSULT LEGAL 
COUNSEL FOR THE INTERPRETATION OF ANY LAWS APPLICABLE TO THE 
AREA OF INTENDED USE OF THESE PRODUCTS. 
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InstallationInstallationInstallationInstallation    Section 3 

Recommended System requirements 

RavTrack PC is a Windows application.  For small or stand-alone  systems, it uses a 
Microsoft Access database to store its information in.  For larger system, deep 
logging, or multi-user applications, we recommend using a Microsoft SQL server to 
store the primary database.  This manual describes the features, installation, and 
configuration of the  SQL Server version of RavTrack PC.  

If your server will LOG tables with more than 300,000 log entries at a time or your refresh rate in a multi-user 
environment will be faster than 10 seconds, we recommend you use a business-grade server to hold the 
LOG and TrackedObject database. Typical minimum requirements are: 

 Intel® Xeon® E55xx processor or faster 
 6GB of RAM 
 Server-grade hard-drives  
 Supported Databases: 

1. Microsoft SQL Server 2005 
2. Microsoft SQL Server 2005 express (10GB database limit) 
3. Microsoft SQL Server 2008 
4. Microsoft SQL Server 2008 
5. Microsoft SQL Server 2012 

 

Program Dependencies 

RavTrack PC is built using Microsoft’s .NET foundation. The computer 
RavTrack PC is installed on must have Microsoft’s .NET version 4.0 or higher.  If 
.NET is not on the computer, the RavTrack PC install program will initiate a 
download of it first, before installing RavTrack PC.   

 RavTrack PC uses Crystal Reports 10  to create and view reports.   

SQL Server Version  Installation Steps 

1. Visit www.ravtrack.com and go to the “Downloads” section of the website.   

2. Log into the website. If you are a new user, create a user account.  

3. Click on the RavTrack PC software program link to download it to your 
computer.   

4. A ZIP file containing an executable program called Setup5.zip  will download 
to your computer.  It is a fairly large download, typically 100-130MB, so it will 
take some time to download.   

5. Once the download is complete, open the .ZIP file and double-click on the file 
RavTrackPC.exe contained in the .ZIP file.  

6. Run the downloaded setup.exe file, and follow the setup instructions.   
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7. RavTrack PC is now installed on the computer.  Proceed with the first-time 
setup instructions. Ravtrack PC by default uses a locally stored Microsoft 
Access database to hold its information.  Once installed, you can modify this 
default to utilize a SQL server if you wish.   

8. If you will be using Microsoft SQL Server as your database, install the SQL 
Server software first and create a “RavTrack” database, before running 
RavTrack PC.   

9. The first computer to start RavTrack PC will create the tables in the RavTrack 
database, so that computer must have full administration rights to the 
database. For Microsoft ACCESS databases, this should not be an issue. For 
SQL databases, you may need to temporarily allow the client full rights to the 
RavTrack database.  

Databases 

When you choose to use Microsoft SQL Server for your RavTrack PC database, all 
of the location information of the GPS tracked vehicles will be stored in the SQL 
database called “RavTrack“.   You must create this database manually using 
Micrtosoft’s Management Studio software program, and then assign the user login 
rights to the database.  RavTrack PC will create the tables within the database.  

The steps to take to setup the RavTrack SQL database in SQL Server 2005 or 2008 
are as follows: 

i. Using the Management studio, create a database with the name 

“RavTrack”. You do not need to create any tables in the database, as 

RavTrack PC will create them the first time it connects to this 

database. 

ii. Using Management Studio, create security login accounts for the 

users that will be using RavTrack PC on the network.  Right click on 

Databases > Security > Logins > New LoginN  to create a new login 
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account for each user. Set the Server Role to “serveradmin”.  

 

iii. Using Management Studio, assign the new user login to the RavTrack 

database.  Right click on Databases > RavTrack > Security > Users . 

Add UserN  to add the new user to the database.   

iv. Set the Role Members” to db_datawriter and b_datareader. 
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v.  

Management Studio is a very good tool to use not only for configuring SQL Server, 
but also to verify that connections to the RavTrack database are OK.   On any 
workstation that you feel there is a login problem with the database, login to that 
workstation with the user name and password, run Management Studio, and try to 
access the RavTrack database.  If you can access it and list the tables, then the 
user name and password has the proper rights configured on the server.  

There is a verion of Microsoft SQL Management Studio for every version of their 
SQL Server program 

 

Microsoft SQL Server Configuration 

If you are going to use a Microsoft SQL Server 2005, 2008, 2012, or 2014, database 
with RavTrack PC, then you will need to prepare the SQL Server first, before running 
RavTrack PC.  Microsoft SQL Server requires expertise in database installation and 
administration.  Microsoft SQL Server does not have to be installed on a computer 
running a server operating system.  It may be run on a Windows XP, Vista, 7 or 8 
computer.   
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SQL Server installation is often very challenging for personnel not trained in 
Microsoft SQL Server management.  Raveon highly recommends that professional 
IT consultants with proper experience and training setup and configure the SQL 
Server software and computer.    

If your network has a domain controller, then all computers, clients, and servers 
should be part of that domain, or a member of a domain with a mutual trust between 
the domains. Setting up mutual trust is a complicated procedure and should be done 
with a great deal of care and due security considerations.   

Client computers running RavTrack PC Standard that remotely connect via a 
network to the SQL Server computer will need to be “Authenticated”.  Authentication 
ensures that the client computers have the right to access the SQL Data.  There are 
two ways a client computer will be authenticated by SQL Server.   

Windows Authentication.  The user name and password that the person 
logged onto Windows on the client computer is used by SQL Server to 
authenticate the user.   

SQL Server Authentication.  With this method, RavTrack PC must be 
configured with a password and login name.  The same login name and 
password will be configured at the SQL Server. By default Raveon configures 
SQL Server authentication login name as “RavTrackUser” and the password 
is “password”. You my configure it to a name and password that you would 
like.  

Here are some suggested steps when installing MS SQL Server.  Your installation 
may vary: 

1. If you are using Windows Authentication to connect and authenticate 
your computers, make sure that all client computers have 
  A) A login name 
  B) A password  
that matches the EXACT login name and password on the server.  
Windows Login will not work if the account names and passwords are 
not the exact same on the server that runs SQL Server and any client 
machine that wants to connect to it.  

2. Install Microsoft SQL Server or SQL Server Express.  SQL Server 
Express is available from Microsoft at no charge.  

3. Use the “SQL Server Configuration Manager” software program that is 
installed with MS SQL Server to configure the server.  Be sure to 
enable the TCP/IP Client Protocol (SQL Server Configuration Manager > SQL 

Native Client Configuration > Client Protocols > TCP/IP). 

4. Also download and install the “Management Studio” for SQL Server.  
The Express version may be downloaded at the same website as the 
SQL Server Express is downloaded from.  To run Management Studio 
as an administrator, right-click on it when you start it, and say “Run 
As3” and then select the administration account to run as.  
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5. Configure the SQL Server Settings using Management Studio 

a. Set the default transaction time-out to 600 seconds (Tools> Options> 
Designers> Transaction Timeout) 

b. Set the “Server Authentication” method to both Windows and SQL Server.  
(right click on the Server in Object Explorer, select Properties, Security 
page) Check the correct button.  

c. Right click on your SQL database server, and select Properties.  Enable the 
type of user authentication you wish to use.  We also recommend enabling 
“Login Auditing” of all login attempts to help trouble shoot authorization 
issues. Make sure if you use SQL Authentication, that the SQL Server and 
Windows Authentication is selected.  

 

d. Using Management Studio, create a database with the name “RavTrack”. 
You do not need to create any tables in the database, as RavTrack PC will 
add them to the database the first time it connects to this database. Set the 
Server Role for the users to  “serveradmin”.   

e. Add Logins to the SQL Server for any user ID that will be using the database.   
(Security > Logins  then right-click Logins and select “New LoginC”) 
Add your user account and password here.  

f. Add the Logins or users that will use RavTrack PC software to the RavTrack 
database.  To add Logins, expand the RavTrack database tab, Security, 
Users.  Then right-click Users to add new users to the database.   
Set the new Login’s “Default Database” to RavTrack.     
Very Important:  Set the “Database Role Membership” for the Login to  
db_datawriter, db_owner, and db_datareader. 

g. Verify the “SQL Server Browser” service is running on the computer.  To 
verify or start the server, go to Control Panel > Administrative Tools > 
Services, and scroll down to find the SQL Server Browser.  Make sure the 
service is Started. If it is not running, other computers cannot discover the 
sever when they scan for SQL servers on the network.  
 

6. If SQL Server was installed on a Windows XP computer, make sure 
the “Simple File Sharing” is  turned off.  To do this, open Windows 

Explorer, select Tools > Folder Options > View, and verify the Use 

Simple File Sharing box is not checked.  

7. On the computer running MS SQL Server, make sure the directory 
services are running so that RavTrack PC workstations can discover 
the SQL Server.  To see if the services are running on the SQL server 

computer, go to  Start > Control Panel > Administrative tools > 
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Services.  The SQL “Server Browser service”, “SQL Server, and SQL 
Server Active Directory Helper”  services should all be started. If they 
are not running, enable and start them.  

Troubleshooting: 

If you are having trouble connecting RavTrack PC to your SQL server installation, 

check the following items: 

i. Shut down RavTrack PC using FIle > Exit, and restart it.  Whenever the 
database type is changed in RavTrack PC, you should restart the 
application. 

ii. Install Microsoft’s Management Studio applicationon the computer 
running RavTrack PC.  Use Management Studio to connect to the server 
to verify that the SQL Server is running properly and accessible from the 
workstation. 

iii. Make sure the the TCP/IP Client Protocol is enabled on the SQL Server. 

iv. Make sure you are logged into RavTrack PC as an administrator with the 
ADMIN account. 

v. Make sure you have purchased and installed an “Unlimited” license on 
RavTrack PC. The “Limited” version will not connect to an SQL Server. 

vi. Make sure you created a database on the SQL server named 
“RavTrack”.  The RavTrack database needs to be on the server before 
running the RavTrack PC program.  Yse the Management Studio to 
create the “RavTrack” database on the server. 

vii. You should have an account on the SQL Server computer with the same 
name and password as the name/password that you used to log onto 
Windows on the RavTrack PC computer. If you have not done this, 
create a Windows user account and password on the SQL Server 
computer to match the Windows user/password on the RavTrack PC 
Windows login account. 

viii. Make sure the rights assigned to the login account are at least 
db_reader, db_writer, and db_admin.  

  

 

RavTrack PC First-Time Setup  

Once the RavTrack PC software is loaded on the computer, you must configure a 
number of settings and add your tracked objects to the database.   

Begin by running the RavTrack PC application.  Select the Start Menu and then 

under All Programs, select Raveon, and then RavTrack PC.  

This will start-up the RavTrack PC software.  The first time the software is run, you 
will see a pop-up window showing the message:  
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RavTrack PC Trial Software License.  Contact Raveon sales to 

purchase a license to use this product. 

Click OK, and let the program begin normally.  Once it begins, enter your license 
information.  RavTrack PC will run for 30 days with the Evaluation license key that is 
automatically installed with the product.  

 The first computer to start RavTrack PC will create the tables in the RavTrack 
database, so that computer must have full administration rights to the database. For 
Microsoft ACCESS databases, this should not be an issue. For SQL databases, you 
may need to temporarily allow the user on the RavTrack PC computer to have full 
rights to administer the RavTrack database.  

 

Entering the License Key 

To use RavTrack PC, you must purchase a license for each copy you will be using.  
Contact Raveon sales (sales@raveon.com) to purchase a license.  Your license key 
will be emailed to you.   

To enter the license key into RavTrack PC, start up the software and select Help > 

About Ravtrack.   

On the About RavTrack PC  help window, there is a button labeled “Modify 

License”.   

 

Click on the Modify License button.  When the pop-up box appears asking for your 
license key, enter the license key that was emailed to you from Raveon. 

 

Enter your license and press the OK button.  

Changing to the SQL Server Database 

By default, RavTrack PC will run using the built-in Microsoft Access database.  To 

reconfigure RavTrack PC to use a Microsoft SQL Server database, select Tools > 

Database Administration from the main RavTrack PC screen.  
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Set the Database Type to “Microsoft SQL”, and choose your server computer from 

the list of servers in the drop-down list.  Then click Connect. 

Once RavTrack PC successfully connects to the SQL server, click Close.   If this is 
the first time that RavTrack PC has connected to the particular SQL database, you 
will get two warning messages.  Click YES on both.  The two warning messages are: 

1. Warning. Missing TrackedObject table. Do you want to re-create it?  

Click Yes to create you new TrackedObject table in the RavTrack SQL 
database. 

2. Warning. Missing LOG table. Do you want to re-create it? 

Click Yes to create you new LOG table in the RavTrack SQL database. 

 

At this point, is it suggested you restart RavTrack PC by selecting File > Exit.  This 
will save the settings and exit the program.  Then restart RavTrack PC.  

Admin User 

Upon installation, the default RavTrack PC user is “admin” and the password for this 
user is “admin” (all lower case letters).  

Crystal Reports 

Crystal Reports from SAP is a report generation and viewing program used by 
RavTrack PC to view and print various reports.  To view the Crystal Reports 
included with RavTrack PC 5.x, you must install SAP’s Crystal Reports, version for 
Visual Studio 2010.  It is a free download available from SAP here:  
http://scn.sap.com/community/crystal-reports-for-visual-studio   In most installations, 
there is a link to the Crystal Reports installer setup on the computer where RavTrack 

PC was installed.  From the Start Menu, open the RAVEON > RavTRACK PC 
folder.  Click on the install Crystal Reports link in this menu. Or, follow the steps 
below to download the Crystal Reports runtime file from SAP.  
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Download the current “Support Pack” for SAP Crystal reports, and install it on the 
computer.  This will install Crystal Report runtime module on the computer.   

 

 

If RavTrack PC is not installed on the C:\ drive of the computer, you will need to 
modify a registry setting for Crystal Reports.  Perform these steps on the registry.   

a) Using Regedit, find the registry sub-key that holds the 
ConnectionDirectoryPath in it.  This will usually have a value of C:\ 

b) Do not changed the ConnectionDirectoryPath  value. 

c) Add a new entry in the same sub-key that holds the 
ConnectionDirectoryPath.  The new entry you must create is called 
ReportDirectoryPath.   

d) Set the ReportDirectoryPath value to the drive letter where RavTrack PC 
resides.  For example, if RavTrack PC is on the E: drive, set the value of 
ReportDirectoryPath to E:\ . 
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RavTrack PC Main Screen Overview 

 

This is the main user-window for the RavTrack PC software program.  You will note 
in the lower-right corner are buttons showing the status of the communications from 
the radio and GPS.  When they show red, there is a problem with the radio 
communications set-up.   

Configure your Communications settings 

See the RavTrack PC User Manual for information on configuring communication 
channels and all other parameters. 

Directory Structure on the PC 

When RavTrack PC is installed, a number of directories are created on the 
computer.  There are data directories for maps, sounds, log files, and data.  These 
directories are all located under one \Ravtrack PC\ sub-directory.   Normally this 
directory is in the C:\RAVEON\... subdirectory.  Previous version of RavTrack PC 
(3.X and 4.X) stored their data in C:\Program Data\RAVEON\...  Currently, version 
5.x stores RavTrack PC data here: 

C:\ Raveon\RavTrack PC\... 
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4\RavTrack PC\Data\   This directory will hold all of the data files for the program 
if the program is configured to use the MS Access database.  The database with for 
the tracked objects, the log file, the system databases are all stored in this directory. 

4\RavTrack PC\Maps\   This directory hold the maps used the the program.  
RavTrack PC installs with a world-map.  Custom maps created by the program’s 
user are stored in this directory.  

4\RavTrack PC\Icons\   This directory has various icons that the user may edit 
and merge into their custom maps.  

4\RavTrack PC\Logfiles\   This directory holds the weekly program operation 
log file.  This is not a database, but a text file describing general program operation, 
events, and errors. It holds the event logs for RavTrack PC, not  the log file for 
vehicle movements.  

4\RavTrack PC\Reports\   This directory hold the Crystal Report files used by 
RavTrack PC.  

4\RavTrack PC\Sounds\   This directory holds sound files (.wav) that can be 
played when an alert is triggered.  

System Database 

RTsystem.mdb 

The  RTsystem.mdb database holds configuration information about the RavTrack 
system.   

It has these tables in it: 

Fences The records in this table hold information about the geo-
fences that have been established, as well as points of 
interest and all user-created graphics and shapes on the 
map.  

AlarmRules As the table name implies, each entry in this table holds an 
individual alarm/alert rule.  Alarm/alert rules specify the 
conditions that trigger alerts as well as the action to take if 
an alert is triggered.  The rules processor in the RavTrack 
PC monitors the objects and verifies every position report 
against these rules, and generates alerts based upon the 
rules.  

RouteData As the table name implies, each this table holds the 
waypoints for routes. At this time, this table is unused.  

AlertingObjects Used by RavTrack PC to manage the list of alerting objects.  

  

  

.  
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Microsoft SQL Server Database 

If the program is configured to use the Microsoft SQL Server database, then the activity log 
is stored in one table, and the tracked object information in a second table.  A third table will 
hold the street-address location information for the tracked objects.  All three tables are held 
in one SQL database called “RavTrack”.  There may also be numerous backup copies of the 
LOG table. 

ObjectData Records for each tracked object. Any object such as a car, 
bike, truck, that has a GPS radio transponder on it will have 
an entry in this table, which maintains the current information 
about the object (location, speed, headingN) as well as a 
user-friendly name.  

LocationInfo If reverse geo-coded address information is available, this 
table will hold the street, city, state, country and zip code of 
the location of each tracked object.  

GroupMembers The list of groups and the IDs that belong to the groups.  

Groups The list of all groups defined in the system.  

ObjectInfo The free-format table containing user-defined fields with 
information about the IDs in the system.  

UserRestrictions The list of restrictions applied to the various users.  

Users The list of all of the user names in the system.  

LanufageText A table with columns for various languages.  The translation 
text for much of the text in RavTrack PC is stored in this file, 
and users may add new language columns as needed.  

Log Records for each position/status received by the RavTrack 
PC program.  The RavTrack PC program may be configured 
to store every reception in the log, store only data from 
moving objects in the log, or store nothing in the log.   

LOG_-xxxxx Backup-copies of the LOG table.  The date of the backup is 
in the table name.  For example, the table LOG_2009_10_27 
was created October 27, 2009.  .   
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System Log Database 

On the Program Operation tab, the user may enable the Track Log.  The Activity 
Log is a database table that holds position and status information about the objects 
that have reported their position and it holds each Alert Event if the alert was 

configured to be logged.  Select Log position and alerts to database to enable 
saving position/status reports to the Log table.   

 

On busy systems, the Log table in the database may grow quite large, so there is 
an option to limit the logging of position/status report from object to only those from 

moving objects.  Click on Only Log moving object and enter the distance they 
must move if only position/status information about moving objects is to be saved 
to the log.   

Units and Display Options 

The Units and Display tab allow the operator to select how some aspects of the 
RavTrack PC display information.  The data stored on the SQL server is also 
stored in the same format as configured here.  
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Metric or English Units 

The program can display speed and distance in either Metric or English format.  
Log entries in the Log database as well as status entries in the tracked objects 
database are stored using the selected format.   

Use caution when changing the units or measure and later analyzing the data. If 
the system of measurement was set to one type and then data was stored in the 
database, when it is changed to another format, the databases still holds the old 
data in the old units of measure, and thus data recalled from them may be 
displayed incorrectly.  For example, if the program is set to metric, and an object 
was recorded going 100km/hour, the speed is saved in the LOG table as 100.  
This simplifies the reporting for anyone using the log file, because the unit of 
measurement in the log is the same as set in the program.  But if the program is 
later changed to English units and the log file is retrieved, it will show the speed as 
100 miles per hour for the previous entry.   

to this fence.  Fence names used in geo-fencing are not case sensitive.  Carlsbad 
and CARLSABD will be treated as the same fence name.  
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    The Log FileThe Log FileThe Log FileThe Log File    Section 9 

A LOG table is a table stored in a database that holds historical information about the 
location and status of the tracked objects.  The log table in the RAVTRACK SQL 
database file is named LOG.  

Following is a list of the fields stored in the log file for each position/status reception 
from a tracked object.  

 

The LOG table holds the data for the log entries. The field in the LOG table named 
“EntryType” identifies the type of entry in this log file.  The valid types are: 

Update A position/status update was received over the radio from a tracked 
object, and this is the log entry for that event.  

Alert A rule was triggered and this is the log entry for the alert.  

Clear A tracked object had been triggering a rule alert, but the event has 
cleared.   

System Log 

Additionally, a text file is created and various system activities related to the RavTrack 
PC operation and its actions are recorded in it.  The system log file is called RT-w-
yyyy.txt  where w is the current week number, and yyyy is the current year.  Every week 
a new system log file is created.   

The RT- system log files are stored in a subdirectory under the N\RavTrack PC\Logfiles 
directory. 

Any text viewing program may be used to review the system log file. These are provided 
for system and installation debugging purposes. 
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Enabling Activity Logging of Tracking  Objects 

Logging the position, status, and alerts received by RavTrack PC to the LOG table is a 
two-step process.   

1. Enable the activity logging feature in RavTrack PC. 

2. Enable logging for the individual tracked object  

To enable RavTrack PC to store GPS position data, status, and alerts in the LOG table, 

select File, Program Properties from the main screen. From the Properties screen, 

check Log position and alerts to database.   

If you only wish to log objects that are moving(recommended), also check Only Log 

moving objects, and specify the minimum distance an object must move before its 
location and status are stored to the LOG table.  

 

If you only store information to the Log table when an obejct is moving, you may also 
want to also periodically store an update to the Log table. To for a periodic entry in the 

log table for stationary objects, check the Log at least every xx seconds box, and 
enter the maximum number of seconds you wish to have between Log table entries for 
any particular vehicle.  

For example:  In the configuration above, RavTrack PC will store every postion report 
received from any vehcile that moves more than 100 feet.  If the vehicle does not move 
in 15 minutes (900 seconds), then it will store an entery in the Log table anyway, and 
continue to do so every 15 minutes seconds untill the object begins moving.  Each time 
the object moves more than 100ft between postion reports, a log entry will be made. 
This configuration is recommend so that the Log table does not grow excessivly large.  

Once logging is enabled, it still must be enabled for the individual tracked objects.  
When a tracked object is first defined, by default, activity logging for the object is 
enabled.  

To enable/disable logging of individual tracked objects, first double-clicking on the 

object in the database window, or select Tools, Add/edit tracked objects.   

Locate the object in question, and check Store reports to the log file to enable logging 
for this object.  If checked, every time the object transmits a position/status, the 
specifics of the transmission are stored in the LOG table. 
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Log Table Size Limitation 

All databases have size limitations, and because the LOG table can grow over time to 
be quite large, the user must be aware of the size of the LOG table, and manage it 
properly by “Pruning” it to remove old data, and periodically backing it up. 

For Microsoft SQL Server the LOG table should be kept to 400,000 entries.  These are 
not “Hard” limits, and the actual limit will greatly depend upon the performance of the 
computers running the database software.  A high-performance business-class server 
should have no trouble processing 1,000,000 LOG table entries.  

Below is a table to help you estimate the number of LOG table entries that RavTrack PC 
will make per day, week, and month.  This will help you configure how often RavTrack 
PC should prune the records in the LOG table.   

Number 
of 

Tracked 
Objects 

Update 
Rate 

(seconds) 

Usage 
per day 

Log Only 
Moving? 

Log Entries 
per day 

Log Entries per 
week 

Log Entries 
per month 

10 10 24 no 86,400  604,800  4,233,600  

10 10 24 Yes 8,640  60,480  423,360  

10 30 8 Yes    960     6,720  47,040  

50 10 24 no 432,000  3,024,000  21,168,000  

50 30 24 Yes  14,400      100,800  705,600  

50 60 8 Yes     2,400     16,800   117,600  

200 30 24 no  576,000    4,032,000  28,224,000  

200 60 24 Yes    28,800       201,600  1,411,200  

200 120 8 Yes      4,800           33,600      235,200  

 

Log Table Management 

Position reports and alert events may be stored in a database table called the LOG.  
Each individual tracked object may be configured to store its postion/status reports to 
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the LOG table, as well as rules may be configured to store events to the LOG table if 
the rule is triggered.   

All entries in the LOG table are sequentially numbered and dated.  This facilitates 
management and reporting.  To erase some or all of the entries in the LOG table, select 

File, Manage Log Database from the main screen.  When you start this Log Table 
Management utility, a window will pop-up allowing you to review and configure how the 
LOG table is managed.  

A RavTrack PC user must be either an Administrator or have the rights to “Manage the 
LOG table” assigned to the user to open this Log Table Management window.  

 

To enable a computer to manage the LOG table and its backups, check the Enable 

LOG Management checkbox on the top left of the window.  

The window “List of LOG tables and backups” will show you the LOG table which has 
the table name “LOG” and the number of records in it, as well as a list of backup-copies 
of the LOG table.  The backup copies have the date they were created in their name, 
such as Log_2010_1_13.  This table was created January 13st, 2010.   

The main LOG table that holds the current log information in it is simply called “LOG”.   

Use the Manually Delete Old LOG Entries selection to erase old log entries and 
reduce the size of the log database.  

To erase all entries in the log file, select Clear All.   

To delete an old log table, right-click on it, and select Delete. 
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Note, each entry in the log file uses approximately 1000 bytes in a MS SQL Server 
database.    

Pruning the LOG table 

For optimum performance, the main LOG table should not grow excessively large, so it 
periodically should be “Pruned”.   Pruning removes old entries.  Use the Auto Prune 
feature to automatically have RavTrack PC remove old log entries from the LOG table.   

Check the Erase Old Entries checkbox to enable the LOG table Auto Prune feature.  

The select the maximum age for LOG table entries by setting the Older Than XX days 

value.   For example, if it is set to Older Than 10 days, RavTrack PC will automatically 

remove log entries that were placed in the LOG table more than 10 days ago. T 

 The date of an individual record in the LOG table is dependent upon the date set on 
the computer that stored the LOG entry.  Care should be taken to ensure that 
computers which store LOG entries have their date and time properly set.  

Backing Up the LOG Table 

 Only one computer on a RavTrack PC system should be configured to automatically 
backup the LOG table.  All others should have their backup option set to “Manual”. 

Configure automatic backups using the “Backup Log Table” drop-down list on the 

Mange Lot Table window.   Daily, Weekly, Monthly, or Manual may be selected.  At 
the interval you select, RavTrack PC will copy the LOG table to another table named 
LOG_xxxx where xxxx is the date of the copy.   

Third-Party SQL Table backups Software 

On RavTrack PC systems with a large number of vehicles or vehicles that report very 
quickly, the LOG table may get large quickly.  In this case, Raveon recommends that a 
third-party table backup program be used so that the SQL database does not get 
excessively large.   

Configure your backup software to periodically backup the LOG tables, and once they 
are backed up, delete the old ones from the SQL database so they do not consume 
resources.  Then, if the historical log data is ever needed, you can restore the 
appropriate log table back to the database so it can be reviewed or replayed.  

The following is a list of possible third-party SQL backup software vendors.  

Quest Software 

http://www.quest.com/sql-server/backup-and-recovery.aspx  

SteeleEye Technologies 

http://www.steeleye.com/ 

Red-Gate 

http://www.red-gate.com/index.htm  
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    MultiMultiMultiMulti----User OperationUser OperationUser OperationUser Operation    Section 11 

RavTrack PC may be run on multiple computers, all monitoring, tracking, alerting, 
logging, and reporting on the activity of the system.  If a RavTrack PC is configured as a 
“Client” it will get the information it displays on the map and in the Tracked Object 
database window from a remote Database Server.  

 RavTrack PC uses a time/date field in the database to synchronize the various 
workstations running RavTrack PC.  It is very important that the time and the date on all 
of the PCs in the system be correct, to within 20 seconds of each other.   

When Microsoft SQL Server is used, the shared database name is RAVTRACK and the 
table that holds the location/status information for all tracked objects is called 
ObjectData.  

To configure a PC for multi-user operation: 

1. Setup the RavTrack database on an SQL server, accessible on your network.  

2. Select File> Program Properties> Servers tab to configure access to the Tracked 
Object database.  

3. Click on Configure  Database Server.  Change the “Tracked Object Database File 
Location” to the common shared directory where the “TheTrackedObjects” 
database is stored.  In the example below, it was stored on a server’s P: drive in 
the RavTrackPC subdirectory.  
Click on Configure  Database Server.  Set the Database Type to Microsoft SQL 
Server.  In the Server: drop-down list, choose the server that you installed the 
RavTrack database on.  

4. On the Servers tab of the Program Properties window  check the Client – 

Periodically Read from Server  radio button.   
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Client computers on a multi-user RavTrack PC systems will periodically synchronize the 
Tracked Objects that are displayed on the map with the data in the shared database 

table.  How often this refresh is done may be set in with the “Database Refresh 

Interval”.  During refresh, the PC may respond a bit slower, so it is best to do this as 
infrequently as possible.  Raveon suggests every 60 seconds.   

When Multi-User Operation is configured as a Client, RavTrack PC will periodically 
send a query to the SQL Database Server asking for a list of all new position 
information.  When new position/status information is returned from the Database 
Server, this new information will be processed as new position/status reports, checked 
against the rules, and logged to the LOG table as appropriate.  

On a multi-user system, one RavTrack PC computer updates the SQL database 
Server, and will update the database tables with the Tracked Object information and 
event Log table.   

The RavTrack PC computer that updates the SQL database in a multi-user system is 
connected to the Raveon GPS transponder and receives position information over-the-
air from the vehicles being tracked.  This computer may be configured as a Stand-
Alone because it does not have to retrieve position information from the server.  It 
already knows the position of all objects because it is receiving them over-the-air and 
storing them to the database.   

Restricting Access by User Group 

When an installation of RavTrack PC is configured for Multi-User, it retrieves information 
about the location and status of all vehicles from an SQL database.  It periodically 
retrieves the location/status records from the database.  

You may restrict which vehicles the RavTrack PC program displays.  The restriction is 
based upon the User Group that the vehicle is assigned to.  For example, you may 
have a RavTrack system tracking trucks and cars, but would like to have a workstation 

that only shows the location of the trucks. Enabling the Restrict Access by User Group 

feature will block viewing of all vehicles unless the User Group is enabled for viewing.   
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To enable the Restriction by User Group, from the main screen, select File > Program 

Properties and click on the Options tab.  Check the Restrict Access by User Group 

checkbox.  In the My Record Restrictions frame, you will see a list of all of the groups 
on your system.  Check the groups that this computer should be able to see.   

Like most all RavTrack PC configuration options, you must be signed into RavTrack PC 
with administrator privileges to modify the Record Restrictions.  Once a workstation is 

configured for Restricted Access by User Group, you may want to login to RavTrack 
PC with a user name that has limited rights to modify the configuration.  This will stop 
the RavTrack PC user from modifying the restriction and viewing the location of vehicles 
that he/she is restricted from viewing.  

Note: When the Restricted Access by User Group feature is enabled, the “Auto-
Add” feature will not work.  “Auto-Add” is a feature that will automatically add new 
vehicles to the list of tracked objects if the GPS data from a new previously unheard-
from vehicle is received.  Because RavTrack PC assumes that a computer with 
restricted group access is only supposed to view and track certain groups, the location 
and status information from new vehicles which are not already a member of one of the 
allowed groups will be ignored.  
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    Software LicenseSoftware LicenseSoftware LicenseSoftware License    Section19 

ATTENTION: PLEASE READ THIS DOCUMENT CAREFULLY BEFORE 
PURCHASING THIS PROGRAM. THE INDIVIDUAL OR ENTITY READING THIS 
PACKAGE (THE "END USER") AGREES TO BE BOUND BY THE TERMS OF THIS 
LICENSE. IF YOU PURCHASE THIS PACKAGE AND DO NOT AGREE TO THE 
TERMS OF THIS LICENSE, DO NOT USE THE SOFTWARE AND PROMPTLY 
NOTIFY US, AND THE LICENSE PRICE WILL BE REFUNDED. 

The RavTrack PC computer program(s) and the accompanying documentation are 
provided to the End-User by Raveon Technologies Corporation ("Licensor") for use only 
under the following terms.  Licensor reserves any right not expressly granted to the 
End-user. The End-User owns the disk on which the Software is recorded, but Licensor 
retains ownership of all copies of the Software itself.  The End-User assumes sole 
responsibility for the installation, use and results obtained from use of the Software. 

1. License 

End-User is granted a limited, non-exclusive license to do only the following: 

 A) Install and maintain the Software on one computer at any one time. 

 B) Make copies in machine-readable form solely for backup or archival purposes 
for the computer, which the Software is installed. Copyright law protects the Software. 
As an express condition of this License, the End-User must keep the file "License.txt" 
with the archival copies.    

 C) Transfer the Software and all rights under this License to another party 
together with a copy of this License and all written materials accompanying the 
Software, provided (i) the End-User gives Licensor written notice of the transfer 
(including in such notice the identity of the transferee), and (ii) the other party reads and 
agrees to accept the terms and conditions of this License. 

Raveon restricts certain features of the program based upon the type of License Key 
purchased.  Regardless of the type of License Key acquired by the end user, only one 
copy of the Program may be utilized for each individual License Key acquired.  If the 
Program is used with a Trial Key, then the End-User may only use the Program for 30 
days after the Program is first installed, after which the Program must be un-installed or 
a Lite, Standard, or Server Key Purchased.  It may not be re-installed and used with the 
Trial License.  

2. Restrictions 

The End-User may NOT sublicense, assign, or distribute copies of the Software to 
others. The Software contains trade secrets. The End-User may NOT decompile, 
reverse engineer, disassemble, or otherwise reduce the Software to a human readable 
form. THE END-USER MAY NOT MODIFY, ADAPT, TRANSLATE, RENT, LEASE, 
LOAN, RESELL FOR PROFIT, DISTRIBUTE, OR OTHERWISE ASSIGN OR 
TRANSFER THE SOFTWARE, OR CREATE DERIVATIVE WORKS BASED UPON 
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THE SOFTWARE OR ANY PART THEREOF, EXCEPT AS EXPRESSLY PROVIDED 
IN SECTION 1.C. ABOVE. 

3. Protections and Security 

The End-User agrees to use its best efforts and to take all reasonable steps to 
safeguard the Software to ensure that no unauthorized person shall have access 
thereto and that no unauthorized copy, publication, disclosure or distribution in whole or 
in part, in any form, shall be made. The End-User acknowledges that the Software 
contains valuable confidential information and trade secrets and that unauthorized use 
and/or copying are harmful to Licensor. 

4. Termination 

This License is effective until terminated. This License will terminate immediately 
without notice from Licensor if the End User fails to comply with any of its provisions. 
Upon termination the End User must destroy the Software and all copies thereof, and 
the End-User may terminate this License at any time by doing so. 

5. Limited Warranty 

Licensor warrants that, for 90 days from the date of initial use by the original End User, 
the Software shall operate substantially in accordance with the published functional 
specifications current at the time of shipment. If, during the warranty period, a defect 
appears, End User shall return the Software to Licensor and Licensor's only obligation 
shall be, at Licensor's election, to replace the defective Software or refund the purchase 
price. The End-User agrees that the foregoing constitutes the End-User's sole and 
exclusive remedy for breach by Licensor under any warranties made under this 
Agreement. This warranty does not cover any Software that has been altered or 
changed in any way by anyone other than Licensor.  It does not cover bugs, memory 
leaks, stability issues, security, or problems related to Windows, .NET, SQL Server, or 
any other third-party computer software interacting with the Software.  Licensor is not 
responsible for problems associated with or caused by incompatible operating systems 
or equipment, or for problems in the interaction of the Software with software not 
furnished by Licensor. No oral or written information or advice given by Licensor or its 
dealers, distributors, employees or agents shall in any way extend, modify or add to the 
foregoing warranty. 

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU 
OF ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT 
LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE. THE END-USER ASSUMES ALL RISK AS TO THE 
SUITABILITY, QUALITY, AND PERFORMANCE OF THE SOFTWARE. IN NO EVENT 
WILL LICENSOR, OR ITS DIRECTORS, OFFICERS, EMPLOYEES OR AFFILIATES, 
BE LIABLE TO THE END-USER FOR ANY CONSEQUENTIAL INCIDENTAL, 
INDIRECT, SPECIAL OR EXEMPLARY DAMAGES (INCLUDING DAMAGES FOR 
LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF DATA OR 
BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OF OR 
INABILITY TO USE THE SOFTWARE OR ACCOMPANYING WRITTEN MATERIALS, 
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EVEN IF LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES. 

LICENSOR'S LIABILITY TO THE END-USER (IF ANY) FOR ACTUAL DIRECT 
DAMAGES FOR ANY CAUSE WHATSOEVER, AND REGARDLESS OF THE FORM 
OF THE ACTION, WILL BE LIMITED TO, AND IN NO EVENT SHALL EXCEED, THE 
AMOUNT ORIGINALLY PAID TO LICENSOR FOR THE LICENSE OF THE 
SOFTWARE. 

6. Enhancements 

From time to time Licensor may, in its sole discretion, advise the End-User of updates, 
upgrades, enhancements or improvements to the Software and/or new releases of the 
Software (collectively, "Enhancements"), and may license the End-User to use such 
Enhancements upon payment of prices as may be established by Licensor from time to 
time. All such Enhancements to the Software provided to the End-User shall also be 
governed by the terms of this License. IN ORDER FOR THE END-USER TO BE 
ASSURED THAT IT WILL BE ADVISED OF AND LICENSED TO USE ANY 
ENHANCEMENTS TO THE SOFTWARE, THE END-USER MUST COMPLETE, SIGN 
AND RETURN TO LICENSOR THE ATTACHED END-USER REGISTRATION FORM. 

Generally, licensed und-users may obtain minor upgrades at no charge.  Major updates 
of RavTrack PC may be obtained for an upgrade fee. Please contact Raveon for 
upgrade fees. Minor upgrades are designated by version numbers where the integer 
portion does not change.  For example, version 2.3 to 2.7 is a minor upgrade.  Major 
upgrades are where the integer portion of the version number changes.  Version 2.7 to 
3.0 is major upgrade and will require the purchase of a license for the upgraded version 
of the software.  

7. Disputes  

This license agreement shall be governed by, construed and enforced in accordance 
with the laws of the California, as it is applied to agreements entered into and to be 
performed entirely within such jurisdiction. 

To the extent you have in any manner violated or threatened to violate Raveon 
Technologies Corporation and/or its affiliates' intellectual property rights, Raveon 
Technologies Corporation  and/or its affiliates may seek injunctive or other appropriate 
relief in any state or federal court in the State of California, and you consent to exclusive 
jurisdiction and venue in such courts. 

Any other disputes will be resolved as follows: 

If a dispute arises under this agreement, we agree to first try to resolve it with the help 
of a mutually agreed-upon mediator in the following location: San Diego County, USA. 
Any costs and fees other than attorney fees associated with the mediation will be 
shared equally by each of us. 

If it proves impossible to arrive at a mutually satisfactory solution through mediation, we 
agree to submit the dispute to binding arbitration at the following location: San Diego 
County, under the rules of the American Arbitration Association. Judgment upon the 
award rendered by the arbitration may be entered in any court with jurisdiction to do so. 



Section5  RavTrack PC User Manual 

 38 

8. General 

If any provision of this License is held by a court of competent jurisdiction to be invalid 
or unenforceable to any extent under applicable law, that provision will be enforced to 
the maximum extent permissible and the remaining provisions of this License will 
remain in full force and effect. Any notices or other communications to be sent to 
Licensor must be mailed first class, postage prepaid, to the following address: Raveon 
Technologies Corporation, 2460 Impala Drive, Carlsbad, CA 92010 – USA. 

This Agreement constitutes the entire agreement between the parties with respect to 
the subject matter hereof, and all prior proposals, agreements, representations, 
statements and undertakings are hereby expressly cancelled and superseded. 

This Agreement may not be changed or amended except by a written instrument 
executed by a duly authorized officer of Licensor. 

9. Acknowledgment  

BY INSTALLING THIS SOFTARE PROGRAM, THE END-USER ACKNOWLEDGES 
THAT IT HAS READ THIS LICENSE, UNDERSTANDS IT, AND AGREES TO BE 
BOUND BY ITS TERMS AND CONDITIONS. 

If you have any questions concerning this License, contact Licensor at the address set 
forth below. 

Raveon Technologies Corporation  

2460 Impala Drive 
Carlsbad, CA 92010 – USA 

www.raveon.com 

Phone +1-760-444-5995 
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    End User RegistrationEnd User RegistrationEnd User RegistrationEnd User Registration    FormFormFormForm    Section20 

 

To be eligible for upgrades and notices of improvements to RavTrack PC, please 
register your software with Raveon by mailing or emailing in the following information.   

Your Name:  _____________________________________ 

Company Name _____________________________________ 

Address: _____________________________________ 

City: _____________________________________ 

State: _____________________________________ 

Postal Code: _____________________________________ 

Email Address: _____________________________________ 

License Code: _____________________________________ 

Current RavTrack PC Version:   __________________ 

 

Send the above to: 

 

Raveon Technologies Corporation  

2461 Impala Drive 
Carlsbad, CA 92010 

Phone: +1-760-444-5995 
Fax: +1-760-444-5997 

Or Email it to your account manager at Raveon.  

 

Raveon also appreciates any suggestions you may have for improvements to this 
product.  Please let us know about any ideas or suggestions you have.  

______________________________________________________________ 

______________________________________________________________ 

______________________________________________________________ 

______________________________________________________________ 

______________________________________________________________ 

______________________________________________________________ 
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For More Information 

For more information about this or any other Raveon product, call in the U.S.A.  
1-760-444-5995 or visit us a www.ravtrack.com.     

 

 

Raveon Technologies Corporation  

990 Park Center Drive,  Suite C 
Vista, CA 92081 

Phone: +1-760-727-8004 
Fax: +1-760-598-8004 


